
MG70-EI

取扱説明書 / Instruction Manual

EtherNet/IP インターフェイスユニット メインモジュール / 

EtherNet/IP Interface unit Main module

お買い上げいただき、ありがとうございます。

ご使用の前に、この取扱説明書を必ずお読みください。

ご使用に際しては、この取扱説明書どおりお使いください。

お読みになった後は、後日お役に立つこともございますので、必ず保管してください。

Read all the instructions in the manual carefully before use and strictly follow them. 

Keep the manual for future references.



PRECAUTIONS FOR CORRECT USE

 Connect cables to the unit property as shown in the 

instruction manual. Not doing so may result in a failure of 

the unit.

 Do not install the unit in the following places:

• Locations subject to direct sunlight

• Locations subject to temperatures or humidity outside the 

range specified in the specifications

• Locations subject to condensation as the result of severe 

changes in temperature

• Locations subject to corrosive or flammable gases

• Locations subject to dust (especially iron dust) or salts

• Locations subject to exposure to water, acid, oil, or chemicals

• Locations subject to shock or vibration

 Take appropriate and sufficient countermeasures when using 

the unit in the following locations:

• Locations subject to static electricity or other forms of noise

• Locations subject to strong electromagnetic fields

• Locations subject to possible exposure to radioactivity

• Locations close to power supplies

 Do not drop the product to the ground or expose to excessive 

vibration or mechanical shocks. The product may be damaged 

and may not function properly.

 Use a dedicated packing box to transport the unit. Avoid 

excessive shock or vibration during transportation.

 Wire the unit properly as shown in the instruction manual.

SAFETY PRECAUTIONS

 Definition of Precautionary Information

 Caution
Indicates a potentially hazardous situation 

which, if not avoided, may result in minor or 

moderate injury, or property damage.

 Cautions

 Caution

Do not attempt to take any unit apart while the power 

is being supplied. Doing so may result in electric shock.

Do not attempt to disassemble, repair, or modify any 

units. Any attempt to do so may result in electric shock.

 Do not use the product at voltages other than the 

specified power voltage. This could result in a fire or 

electric shock.

 Do not perform installation work with wet hands. This 

could result in an electric shock.

 Do not disassemble or modify the product. This could 

result in a burn or other injury. Disassembling or 

modifying the product will void the warranty.

 Do not damage, modify, excessively bend, pull on, place 

heavy objects on or heat the cable. This could damage 

the cable and result in a fire or electric shock.

PRECAUTIONS FOR SAFE USE

 Take all possible safety measures when mounting the product 

and operating a mounted device.

 When connecting and disconnecting a signal cable, be sure to 

grasp by the plug section, not the cable.

 The product does not have an explosion-proof structure. 

Therefore, do not use the unit in an atmosphere containing 

flammable gas. This could result in a fire.

 If anything unusual (smoke, sound, smell, etc.) occurs 

during installation or operation, immediately unplug 

connection cables and contact the Service Center. Continued 

usage in this situation can result in a fire, electric shock, or 

breakdown.

System names and product names used in this manual are 

the trademarks or registered trademarks of the respective 

companies.

Trademarks



 

 
1 (E)

 
 

Contents 
Contents ................................................................................................................................... 1 

1. Introduction .......................................................................................................................... 2 

2. Basic Information ................................................................................................................ 3 

2.1. Equipment used .............................................................................................................. 3 

2.2. Equipment connection configuration ............................................................................... 4 

3. Downloading the necessary files ....................................................................................... 5 

4. MG70-EI (X20BC0088) main unit settings ......................................................................... 6 

4.1. IP address settings .......................................................................................................... 6 

4.2. Downloading the configuration file .................................................................................. 9 

5. Operations to be performed using Logix Designer ....................................................... 10 

5.1. Importing L5K file .......................................................................................................... 10 

5.2. Reflection to an existing project ..................................................................................... 11 

5.3. IP address settings ........................................................................................................ 15 

6. (Reference) Creation of various files by the user .......................................................... 16 

6.1. FieldbusDESIGNER introduction .................................................................................. 16 

6.1.1. Overview ................................................................................................................. 16 

6.1.2. Installation procedure ............................................................................................. 16 

6.1.3. License registration ................................................................................................ 17 

6.2. Downloading the necessary files .................................................................................. 18 

6.3. Operations to be performed using FieldbusDESIGNER ............................................... 18 

6.3.1. Hardware upgrade .................................................................................................. 18 

6.3.2. New project creation ............................................................................................... 20 

6.3.3. Build project ............................................................................................................ 23 

6.3.4. Build ........................................................................................................................ 26 
 



 

 
2 (E)

1. Introduction 
 

The MG70-EI is a EtherNet/IP Interface unit Main module created by Bernecker + 
Rainer Industrie Elektronik (hereafter, B&R) and sold by Magnescale Co., Ltd. 

 
This manual describes the operation necessary in the Rockwell Automation 

development environment (Logix Designer) when introducing the MG70-EI, MG71-CM 
and digital gauges. 

 
For information concerning the MG70-EI and MG71-CM, refer to the corresponding 

device specifications available on the B&R website. 
Also, for information concerning Logix Designer, refer to the corresponding Rockwell 

Automation manual and Help function of Logix Designer. 
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2. Basic Information 
 

EtherNet/IP uses the terms “scanner” and “adapter” in place of “master” and “slave”, 
respectively. 

This section shows the adapter (MG70-EI) side components used in the descriptions in 
this manual, and the connection configuration of the various equipment.  

 

2.1. Equipment used 
 

Table 2-1 List of equipment used on the adapter side 

Magnescale 
model name 

B&R 
model number 

Description Appearance Qty. 

MG70-EI X20BC0088 ×1 
X20BB80 ×1 
X20PS9400 ×1 
X20TB12 ×1 

EtherNet/IP Interface unit 
Main module (adapter) 

 

1 

MG71-CM X20DC11A6 ×1 
X20BM11 ×1 
X20TB12 ×1 

Counter module 

 

1 

 Supplied cable used to 
connect a Counter module 
and a digital gauge 
* When shipped from the 

factory, the loose wire side 
of the supplied cable is 
connected to the Counter 
module. 

 
1 

DK800S Series 
or 
DK10/25/50/100 
Series 

 Digital Gauge 
 - DK800S Series 

 1 
Digital Gauge 
 - DK10/25/50/100 Series 
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2.2. Equipment connection configuration 
 

 
Fig 2-2  Adapter side connection diagram 

 
The Ethernet cable used to connect the scanner side and the MG70-EI should be 

shielded in accordance with the operating environment. Use a shielded RJ45 (8P8C) 
connector as the MG70-EI side connector. 

 

X20BB80 

X20PS9400 X20TB12

X20TB12 X20DC11A6

X20BC0088

Ethernet cable 
(MG70-EI side: RJ45 connector)

DC24V

GND

Supplied cable 
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Yellow 
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Gray 

Green 

Purple 

Red 

White 

MG70-EI

Scanner side 

Digital Gauge 

MG71-CM

X20BM11 
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3. Downloading the necessary files 
 

1. Access the Magnescale website 
(http://www.magnescale.com/mgs/language/english/), and select: 
 “Products” 
→ “Digital Gauge” 
→ “MG70/71” 
→ “Software” 
Click “Download” of the MG70-EI corresponding to the number of MG71-CM to 
be used, and download the file. 
 

2. Save the downloaded file in the appropriate location, and extract the file using 
file extraction software. 
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4. MG70-EI (X20BC0088) main unit settings 
 

4.1. IP address settings 
 

The main unit IP address settings are made using the X20BC0088 Web server 
function. 

 
Check the following items before making the settings. 
・The number of nodes switch of the X20BC0088 should be set to “0xFF” before 

supplying power to the X20BC0088. 
・The development computer and the X20BC0088 should not be connected. 

* This is to prevent IP address conflict between the development computer and the 
X20BC0088. 

 
1. Temporarily set the IP address of the development computer to “192.168.100.2” 

and the subnet mask to “255.255.255.0”. 
 

2. Use an Ethernet cable to directly connect the development computer and the 
X20BC0088. 
 

3. Start up a Web browser such as Internet Explorer. 
 

4. Enter “192.168.100.1” in the URL field and access that IP address. 
This operation enables access of the X20BC0088 Web server. 

Fig 4-1 X20BC0088 -- IP address setting -- No.1 
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5. Select “Advanced” from the left menu, and select “Set Network Parameters” 
from the expanded menu. 

Fig 4-2 X20BC0088 -- IP address setting -- No.2 
 

6. Click “Login”. 
Set “Username” to “admin” and “Password” to “X20BC0088” , and click “Login”. 
* The username and password can be changed from “Advanced” after login. 
 

7. Click “Reset Form”. 
The default network parameters are automatically entered. 
After that, set “Host name”, “IP address”, “Subnet mask”, and “Standard 
gateway” to the desired values (the values to be used with the actual network), 
and click “Submit”. 
* In the example in this manual, “IP address” is set to “192.168.0.100” and 

“Subnet mask” is set to “255.255.255.0”. 
When using a router, set “Standard gateway” to the IP address of the router. 

Fig 4-3 X20BC0088 -- IP address setting -- No.3 
 

8. Turn off the X20BC0088 power, set the number of nodes switch to “0x00”, and 
then turn the power back on again. 
 

9. Set the network parameters of the development computer to arbitrary values 
within the range that can be accessed relative to the network parameters set in 
step 7 above. 
*In this manual, “IP address” is set to “192.168.0.1” and “Subnet mask” is set to 

“255.255.255.0”. 
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10. Enter the IP address set in step 7 above in the URL field of the Web browser, and 
check that the X20BC0088 Web server can be accessed. 
Also check that the “IP address” and other values of “Network Settings” on the 
“Adapter Status” page have been changed to the values set in step 7. 

Fig 4-4 X20BC0088 -- IP address setting -- No.4 
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4.2. Downloading the configuration file 
 

1. Access the X20BC0088 Web server from the Web browser. 
* In the example in this manual, “192.168.0.100” is accessed. 
 

2. Select “Configuration” from the left menu． 

Fig 4-5 X20BC0088 -- Downloading the configuration file -- No.1 
 

3. Click “Login” to log in. 
* At the factory defaults, “Username” is “admin” and “Password” is 

“X20BC0088”. 
 

4. Click “Browse…” and select the configuration file (filename extension “bin”) 
downloaded in section 3 above. 

Fig 4-6 X20BC0088 -- Downloading the configuration file -- No.2 
 

5. Click “Start Download”. 
The selected configuration file will be downloaded to the X20BC0088. 
The X20BC0088 will automatically restart after the download is completed. 
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5. Operations to be performed using Logix 
Designer 

 
The description in this section uses the Rockwell Automation “Logix Designer V27.00” 

as the development environment. 
This description also uses the Rockwell Automation (Allen-Bradley) 1769-L18ER-BB1B

 (CPU, EtherNet/IP scanner) as the network element. The network is constructed locally, 
and the IP address of each element is set as a static IP address as shown below. 

 
Table 5-1 IP address settings of various equipment used in the description of Logix 

Designer introduction 

Equipment name IP address Subnet mask value 
Development computer 192.168.0.1 

255.255.255.0 
1769-L18ER-BB1B 
㸦CPU，EtherNet/IP scanner㸧 

192.168.0.10

X20BC0088㸦EtherNet/IP adapter㸧 192.168.0.100
 

5.1. Importing L5K file 
 

1. Start up Logix Designer, and select “File” → “Open…” from the menu. 
After that, a file-selection window will be displayed. 

Fig. 5-1 Logix Designer -- Importing L5K file -- No.1 
 

2. Select the L5K file downloaded in section 3 above. 
Project save will be requested, so save the project in the appropriate location. 
* If controller change is requested when saving the project, select any controller 

from the list. (The subsequent procedure is the same regardless of the 
selection.) 

 
3. When the above procedure is performed, a Logix Designer project file (ACD file) 

based on the L5K file contents will be created and automatically open. 

Fig. 5-2 Logix Designer -- Importing L5K file -- No.2 
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5.2. Reflection to an existing project 
 

1. Start up two Logix Designers, open the project created in section 5.1 above in 
one Logix Designer, and open an existing project (or a new project) in the other 
Logix Designer. 
* This manual describes the opening of a new project. 
 

2. Select “ETHERNET-MODULE ST1” under “I/O Configuration” in the project 
created in section 5.1 above, and drag and drop it to “Ethernet” of the new 
project. 
 

Fig. 5-3 Logix Designer -- Reflection to an existing project -- No.1 
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3. With the same operation, move “CopyInputData” and “CopyOutputData” under 
“Tasks” to the existing project side. Likewise, move “ST1_INPUT” and 
“ST1_OUTPUT” under “Data Types” to the existing project side. 

Fig. 5-4 Logix Designer -- Reflection to an existing project -- No.2 
 

4. Open “Controller Tags” with “Edit Tags” of both projects, and move the 
“ST1_inp” and “ST1_out” tags to the existing project side. 

Fig. 5-5 Logix Designer -- Reflection to an existing project -- No.3 
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5. Right-click “MainTask” on the existing project side, and select “Properties”. 

Fig. 5-6 Logix Designer -- Reflection to an existing project -- No.4 
 

6. Select the “Program Schedule” tab in the Properties window, and arrange the 
“Scheduled” items in order of “CopyInputData”, “MainProgram”, 
“CopyOutputData”. 
* Arrange the items so that the program that will use the MG70-EI I/O data is 

located between “CopyInputData” and “CopyOutputData”. 
 
When finished, click “OK”. 

Fig. 5-7 Logix Designer -- Reflection to an existing project -- No.5 
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7. Open the “CopyInputData” program and delete the “ADD” command. 

Fig. 5-8 Logix Designer -- Reflection to an existing project -- No.6 
 

8. Open the “CopyOutputData” program, and delete the “ADD” command． 

Fig. 5-9 Logix Designer -- Reflection to an existing project -- No.7 
 

9. This completes reflection to an existing project. 
  

Delete

Delete
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5.3. IP address settings 
 

1. Start up Logix Designer and open the existing project used in the reflection task 
in section 5.2 above. 
 

2. Right-click the added “ETHERNET-MODULE ST1”, and select “Properties”. 

Fig. 5-10 Logix Designer -- IP address settings -- No.1 
 

3. Select the “General” tab in the Properties window, set “IP Address” to the IP 
address value set in section 4.1 above, and click “OK”. 

Fig. 5-11 Logix Designer -- IP address settings -- No.2 
 

4. This completes the X20BC0088 IP address-setting task on Logix Designer. 
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6. (Reference) Creation of various files by 
the user 

 
To use a number of MG71-CM not available on the Magnescale website with the 

MG70-EI, or to change the I/O data to be used, use the B&R software FieldbusDESIGNER. 
The description in this section assumes that the FieldbusDESIGNER version is 

V3.0.80.42. 
 

6.1. FieldbusDESIGNER introduction 
 

6.1.1. Overview 
 

FieldbusDESIGNER is free software created by B&R, and can be used to create the  
configuration files (EDS file, etc.) for some of B&R’s industrial network bus controllers. 

 

6.1.2. Installation procedure 
 

1. Access the B&R website (http://www.br-automation.com/), and select: 
 Downloadsࠖࠕ 
 Product Groups：Softwareࠖࠕ→
 Software：FieldbusDESIGNERࠖࠕ→
Download “Automation Studio FieldbusDESIGNER”. 
 

2. Extract the downloaded ZIP file and execute “Install.exe”. 
* If the file cannot be executed, execute “\Setups\FieldbusDESIGNER 

V3.0.80.exe” located in the same layer. 
 

3. Select the language to be used by the installer. 
 

4. Start up the Installation Wizard. 
Follow the instructions on the screen thereafter. 
* Select “B&R I/O Configuration” as the installation type. 

 

Fig 6-1 FieldbusDESIGNER -- Selecting the installation type 
 

  

Select
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6.1.3. License registration 
 

If the FieldbusDESIGNER license has not yet been registered, follow the procedure 
below and register the license. 
※The software can be used for a 30-day trial period in the unregistered condition. 

Once this trial period has passed, FieldbusDESIGNER cannot be used until license 
registration is performed. 

 
■Getting a FieldbusDESIGNER serial number 

An 11-digit serial number is needed to register the FieldbusDESIGNER license. 
* A B&R website login account (contact B&R to get an account) and a computer with 
an Internet connection are needed to get the serial number. 
 
1. Access the serial number get request page on the B&R website: 

(http://service.br-automation.com/br_applications/fieldbusdesigner.jsp) 
 

2. Username and password entry are requested. 
Enter the username and password obtained from B&R, and click “Login”. 
 

3. When login is successful, a FieldbusDESIGNER serial number will be displayed. 
Make a note of this serial number. 

 
■Online license registration method 

The license registration method using a computer with an Internet connection is 
described below. 
 
1. Start up FieldbusDESIGNER, and select “Help” → “About Automation Studio” 

from the menu. 
 

2. Click “Relicense…” in the displayed popup window. 
 

3. Enter the 11-digit serial number obtained for FieldbusDESIGNER in the “B&R 
serial number” field of the displayed popup window, and click “License 
automatically (online)”. 

 
4. Authentication is performed online, and if there are no problems, the 

information for the license used will be displayed in a popup window. 
Performing the above procedure completes the license registration. 

 
■Offline license registration method 

The license registration method using a computer without an Internet connection is 
described below. 
 
1. Start up FieldbusDESIGNER, and select ͆Help͇ → ͆About Automation 

Studio͇ from the menu. 
 

2. Click “Relicense…” in the displayed popup window. 
 

3. Enter the 11-digit serial number obtained for FieldbusDESIGNER in the “B&R 
serial number” field of the displayed popup window, and click “License 
automatically (offline)”. 
 

4. Make a note of the entire character string displayed in the “System code 
(Sys-ID)” field of the displayed popup window. 
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5. Access the license registration page on the B&R website. 
(http://service.br-automation.com/softwareRegistration/bin/index.jsp) 
 

6. Enter the character string displayed in “System code (Sys-ID)” in the “System 
Code” field, and click “Register”. 
 

7. An offline activation code will be displayed. Make a note of this code. 
 

8. Return to the previous popup window, enter the activation code in the “License 
code (Sec-ID)” field, and click “OK”. 
 

9. If there are no problems, the information for the license used will be displayed in 
a popup window. 
Performing the above procedure completes the license registration. 

 
 

6.2. Downloading the necessary files 
 

1. Access the B&R website (http://www.br-automation.com/), and select: 
 “Downloads” 
→ “Product Groups：Control and I/O systems” 
→ “Control and I/O systems：X20 System” 
→ “X20 System：Counter modules” 
→ “Counter modules：X20DC11A6” 
  Download “V3.0 HW Upgrade (X20DC11A6) ”. 
 

2. Save the downloaded file in the appropriate location, and extract the file using 
file extraction software. 

 

6.3. Operations to be performed using FieldbusDESIGNER 
 

6.3.1. Hardware upgrade 
 

1. Start up FieldbusDESIGNER. 
 

2. Select “Tools” → “Upgrade…” from the menu. 

Fig 6-2 FieldbusDESIGNER – Hardware upgrade -- No.1 
 

3. The upgradable hardware will be automatically searched online in the displayed 
popup window. However, ignore this search and click “Browse local storage…”. 

Fig 6-3 FieldbusDESIGNER -- Hardware upgrade -- No.2 
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4. A hardware upgrade file selection window will be displayed. 
Select the hardware upgrade file (AS3.0_HW_X20DC11A6.exe) saved in section 
6.2 above. 
 

5. X20DC11A6 will be displayed in the hardware upgrade selection window.  
Make sure that the checkbox contains a check mark, and click “OK”. 

Fig 6-4 FieldbusDESIGNER -- Hardware upgrade -- No.3 
 

6. The X20DC11A6 hardware upgrade process will start. 
A command prompt may pop up and the message “Any errors occurred” may be 
displayed partway through the process. However, ignore these and press the  
“Enter” key. 

Fig 6-5 FieldbusDESIGNER -- Hardware upgrade -- No.4 
 

7. This completes the hardware upgrade required by FieldbusDESIGNER. 
  

Check
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6.3.2. New project creation 
 

1. Start up FieldbusDESIGNER. 
 

2. Select “File” → “New Project…” from the menu. 
 

3. Enter appropriate values in “Name of the project” and “Path of the project” in 
the displayed popup window, and click “Next”. 

Fig 6-6 FieldbusDESIGNER -- New project creation -- No.1 
 

4. Enter appropriate values in “Name of the configuration” and “Name of the PLC”, 
and click “Next”. 
This manual describes the process when simply clicking “Next”. 

Fig 6-7 FieldbusDESIGNER -- New project creation -- No.2 
 

  

Name of the configuration 

Name of the PLC 

Description of the configuration 

Name of the project 

Path of the project 

Description of the project 
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5. Select the bus module used to generate the configuration file. 
In this manual it is necessary to generate only X20BC0088 (EtherNet/IP), so 
this manual describes the process when selecting “EtherNet/IP CPU” and 
clicking “Next”. 

Fig 6-8 FieldbusDESIGNER -- New project creation -- No.3 
 

6. A confirmation window will be displayed for the project to be created. 
Click “Finish”. 

Fig 6-9 FieldbusDESIGNER -- New project creation -- No.4 
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7. New projects can be created by performing the above procedure. 

Fig 6-10 FieldbusDESIGNER -- After creating a new project 
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6.3.3. Build project 
 

1. Right-click “EtherNet/IP” in “Physical View” of the left pane, and select “Open 
EtherNet/IP” from the displayed context menu. 
The new tab “PLC1.CPU [EtherNet/IP]” will open in the center pane. 

Fig 6-11 FieldbusDESIGNER -- Build project -- No.1 
 

2. Right-click the “IF1 (EtherNet/IP)” in the “PLC1.CPU [EtherNet/IP]” tab, and 
select “Insert...” from the displayed context menu. 

Fig 6-12 FieldbusDESIGNER -- Build project -- No.2 
 

3. Select X20BC0088 from the list in the displayed popup window, and click “Next”. 
A confirmation window will be displayed. Click “Next”. 

Fig 6-13 FieldbusDESIGNER -- Build project -- No.3 
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4. X20BC0088 and X20PS9400 will be added in the “Physical View” pane. 
X20BC0088 will also be added in the formerly blank location in the “PLC1.CPU 
[EtherNet/IP]” tab. 

Fig 6-14 FieldbusDESIGNER -- Build project -- No.4 
 

5. Right-click X20BC0088 in the “Physical View” pane, and select “Open X2X Link” 
in the displayed context menu. 
The new tab “PLC1.CPU.IF1.ST1 [X2X Link]” will open in the center pane. 

Fig 6-15 FieldbusDESIGNER -- Build project -- No.5 
 

6. Right-click the blank field below X20PS9400 in the “PLC1.CPU.IF1.ST1 [X2X 
Link]” tab, and select “Insert…” from the displayed context menu. 

Fig 6-16 FieldbusDESIGNER -- Build project -- No.6 
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7. Select X20DC11A6 (located below “Mixed modules”) from the list in the 
displayed popup window, and click “Next”. 
A confirmation window will be displayed. Click “Next”. 

Fig 6-17 FieldbusDESIGNER -- Build project -- No.7 
 

8. X20PS9400 will be added in the “Physical View” pane. 
X20DC11A6 will also be added in the formerly blank location in the “PLC1.CPU 
[EtherNet/IP]” tab. 

Fig 6-18 FieldbusDESIGNER -- Build project -- No.8 
 

9. Repeat steps 6 through 8 above the number of times equal to the number of 
MG71-CM (X20DC11A6) to be used. 
This manual describes the process when adding only one X20DC11A6 below 
X20BC0088. 
 

10. To locate multiple MG70-EI (X20BC0088) on the same EtherNet/IP network, 
repeat steps 1 through 9 above. 
This manual describes the process when using only one MG70-EI (X20BC0088). 
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6.3.4. Build 
 

1. Select “Project” → “Build Configuration” from the menu. 

Fig 6-19 FieldbusDESIGNER -- Build -- No.1 
 

2. After build is complete, check that an error is not output in the “Output” pane. 

Fig 6-20 FieldbusDESIGNER -- Build -- No.2 
 

3. The files generated by build are located in the “Output” folder below the folder 
where the project file is located. 
 

●EthernetIP_CPU1.L5K 
This file is a L5K file for X20BC0088． 
This file is needed when using an Allen-Bradley PLC. 

 
●EthernetIP_CPU1_IF1_ST1.eds 

This file is an EDS file (Electronic Data Sheet) for X20BC0088. 
This file is needed when using a PLC other than an Allen-Bradley PLC. 

 
●EthernetIP_CPU1.txt 

This text file describes information related to the X20BC0088 configuration 
data. 

This file is needed to check the I/O data address map of “EthernetIP_CPU1_ 
IF1_ST1.eds”. 
 

●EthernetIP_CPU1_IF1_ST1_std.bin 
This file is a configuration file (binary file) for X20BC0088. 
It can be downloaded directly by using the X20BC0088 Web server function. 
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日本からの輸出時における注意
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ル規制による経済産業省の許可要否につきましては、輸出者様にてご確認ください。

For foreign customers
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that end-use, end user and country of destination of this product do not violate your local government 
regulation.
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安全上の注意

●注意表示の意味

 注意

正しい取扱いをしなければ、この
危険のために、時に軽症・中程度
の傷害を負ったり、あるいは物的
損害を受ける恐れがあります。

●注意表示

 注意

通電中は、端子部に触れたり、本製品を分
解して内部に触れたりしないでください。
感電の恐れがあります。

本製品を分解して修理や改造はしないでく
ださい。感電の恐れがあります。

● 規定された電源電圧以外での電圧で使
用しないでください。火災や感電の原
因となる恐れがあります。

● 濡れた手での取付作業はしないでくだ
さい。感電の原因となります。

● 本製品を分解、改造しないでください。
火傷やケガの恐れがあります。分解・
改造された製品は保証できません。

● ケーブルを傷つけたり、加工したり、
無理に曲げたり、引張ったりしないで
ください。また、重いものをのせたり、
熱したりしないでください。ケーブル
が破損し、火災や感電の原因となる恐
れがあります。

● 本製品の取付作業を行なう際や、取付けた装置を
動作させる場合には、充分な安全を確保してくだ
さい。

● 信号ケーブルの抜き差しの際は、ケーブルでなく
必ずプラグの部分を持って行なってください。

● 本製品は防爆構造になっていませんので、可燃性
ガスの雰囲気中では使用しないでください。火災
の原因となることがあります。

● 設置中や操作中に異常 ( 煙・音・匂いなど ) が発
生した場合、すぐに接続ケーブルを外して、サー
ビスにご連絡ください。そのまま使用すると火災
や感電、故障の原因となります。

使用上の注意

● 取扱説明書に示すとおり、正しく接続してくださ
い。正しく接続しないと、故障する恐れがありま
す。

● 次のような環境には設置しないでください。

・ 日光が直接当たる場所

・ 周囲温度や相対湿度が仕様値の範囲を超える場
所

・ 温度の変化が急激で結露するような場所

・ 腐食性ガス、可燃性ガスのある場所

・ ちり、ほこり、塩分、鉄粉が多い場所

・ 水、酸、油、薬品などの飛沫がかかる場所

・ 本体に直接振動や衝撃が伝わる場所

● 次のような場所で使用する際は、遮蔽対策を充分
に行なってください。

・ 静電気などによるノイズが発生する場所

・ 強い電界や磁界が生じる場所

・ 放射能を被曝する恐れのある場所

・ 電源線や動力線が近くを通る場所

● 製品を落下させたり異常な振動や衝撃を加えたり
しないでください。故障や誤動作の原因となりま
す。

● 本製品を輸送するときは、専用の梱包箱を使用し
てください。また、輸送中に過度な振動や衝撃が
加わらないように注意してください。

● 取扱説明書に示すとおり、正しく配線してくださ
い。

EtherNet/IPインターフェイスユニット メインモジュール
EtherNet/IP Interface unit Main module

MG70-EI

補足説明書 / Supplement

お買い上げいただき、ありがとうございます。

安全にご使用いただくために、本紙と各取扱説明書
を必ずお読みください。

取扱説明書は当社ホームページからダウンロードい
ただくか、最寄りの営業所にお問い合わせください。

ご使用に際しては、本紙と取扱説明書どおりにお使
いください。

お読みになった後は、後日お役に立つこともござい
ますので、必ず保管してください。

h ank you for purchasing this product.

To ensure safe operation, please be sure to read this 
document and each instruction manual carefully.

To obtain the instruction manuals, download them 
from the website of Magnescale Co., Ltd. or contact your 
nearest sales representative.

Be sure to operate the product according to the 
descriptions in this document and the instruction 
manuals.

Be sure to keep this document and all instruction 
manuals in a safe and readily available location for future 
reference.

概要

MG70-EI は、Bernecker + Rainer Industrie 
Elektronik（以下，B&Rと記載）のEtherNet/IP イ
ンターフェイスユニット メインモジュールを（株）マグ
ネスケールが販売するものです。

MG70-EI の基本的な仕様に関しては、以下に示す
B&R製品の資料をご覧ください。

Magnescale
モデル番号

B&R
モデル番号

説明 B&R Web リンク

MG70-EI X20BC0088 EtherNet/
IP
バス・コ
ントローラ
（アダプタ）

http://www.br-
automation.com/
en/products/io-
systems/x20-system/
bus-controllers/
x20bc0088/

X20BB80 バス・コ
ントロー
ラ用
ベース・
モジュー
ル

http://www.br-
automation.com/en/
products/io-systems/
x20-system/system-
modules-for-bus-
controllers/x20bb80/

X20PS9400 電源モ
ジュール

http://www.br-
automation.com/
en/products/io-
systems/x20-system/
system-modules-
for-bus-controllers/
x20ps9400/

X20TB12 端子台 http://www.br-
automation.com/en/
products/io-systems/
x20-system/terminal-
blocks/x20tb12/

MG70-EI を使用するにあたり、L5Kファイルもしく
はEDS（Electronic Data Sheet）ファイルが必要と
なります。これらはMagnescale のホームページから
製品情報ページにアクセスすることでダウンロード
できます。

Magnescale ホームページ :
http://www.magnescale.com/mgs/index.html

L5K ファイルは、Allen-Bradley の PLCを使用する
際に使用します。
Allen-Bradley 以外の PLC を使用する場合は EDS
ファイルを使用します。EDSファイルを使用される
場合の取扱い方については、別途お問い合わせくだ
さい。

取扱説明書

弊社ホームページ
http://www.magnescale.com/mgs/product
Digital Gauge カテゴリ内
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Safety Precautions

 Definition of Precautionary Information

 Caution

Indicates a potentially 

hazardous situation which, 

if not avoided, may result in 

minor or moderate injury, or 

property damage.

 Cautions

 Caution

Do not attempt to take any unit apart 

while the power is being supplied. Doing 

so may result in electric shock.

Do not attempt to disassemble, repair, or 

modify any units. Any attempt to do so 

may result in electric shock.

 Do not use the product at voltages other 

than the specified power voltage. This 

could result in a fire or electric shock.

 Do not perform installation work with 

wet hands. This could result in an 

electric shock.

 Do not disassemble or modify the 

product. This could result in a burn 

or other injury. Disassembling or 

modifying the product will void the 

warranty.

 Do not damage, modify, excessively bend, 

pull on, place heavy objects on or heat 

the cable. This could damage the cable 

and result in a fire or electric shock.

PRECAUTIONS FOR SAFE USE

 Take all possible safety measures when mounting 

the product and operating a mounted device.

 When connecting and disconnecting a signal 

cable, be sure to grasp by the plug section, not 

the cable.

 The product does not have an explosion-proof 

structure. Therefore, do not use the unit in an 

atmosphere containing flammable gas. This 

could result in a fire.

 If anything unusual (smoke, sound, smell, 

etc.) occurs during installation or operation, 

immediately unplug connection cables and 

contact the Service Center. Continued usage in 

this situation can result in a fire, electric shock, 

or breakdown.

PRECAUTIONS FOR CORRECT USE

 Connect cables to the unit property as shown 

in the instruction manual. Not doing so may 

result in a failure of the unit.

 Do not install the unit in the following places:

• Locations subject to direct sunlight

• Locations subject to temperatures or 

humidity outside the range specified in the 

specifications

• Locations subject to condensation as the result 

of severe changes in temperature

• Locations subject to corrosive or flammable 

gases

• Locations subject to dust (especially iron dust) 

or salts

• Locations subject to exposure to water, acid, 

oil, or chemicals

• Locations subject to shock or vibration

 Take appropriate and sufficient countermeasures 

when using the unit in the following locations:

• Locations subject to static electricity or other 

forms of noise

• Locations subject to strong electromagnetic 

fields

• Locations subject to possible exposure to 

radioactivity

• Locations close to power supplies

 Do not drop the product to the ground or expose 

to excessive vibration or mechanical shocks. The 

product may be damaged and may not function 

properly.

 Use a dedicated packing box to transport the 

unit. Avoid excessive shock or vibration during 

transportation.

 Wire the unit properly as shown in the 

instruction manual.

Overview

h e MG70-EI is a EtherNet/IP Interface unit Main 
module created by Bernecker + Rainer Industrie 
Elektronik (hereat er, B&R) and sold by Magnescale 
Co., Ltd.

For the MG70-EI speci� cations, refer to the B&R 
product documentation listed below.

Magnescale
model 
number

B&R
model 
number

Description B&R Web link

MG70-EI X20BC0088 EtherNet/
IP bus 
controller 
(Adapter)

http://www.br-
automation.com/en/
products/io-systems/
x20-system/bus-
controllers/x20bc0088/

X20BB80 Base 
module 
for bus 
controller

http://www.br-
automation.com/en/
products/io-systems/
x20-system/system-
modules-for-bus-
controllers/x20bb80/

X20PS9400 Power 
supply 
module

http://www.br-
automation.com/en/
products/io-systems/
x20-system/system-
modules-for-bus-
controllers/x20ps9400/

X20TB12 Terminal 
block

http://www.br-
automation.com/en/
products/io-systems/
x20-system/terminal-
blocks/x20tb12/

An L5K file or EDS (Electronic Data Sheet) file 
is needed to use the MG70-EI. These files can be 
downloaded by accessing the product information page 
of the Magnescale website.

Magnescale website:
http://www.magnescale.com/mgs/language/
english/

The L5K file is used when using an Allen-Bradley 
PLC.
When using a PLC other than an Allen-Bradley PLC, 
use the EDS fi le. Contact us for the handling method 
when using the EDS fi le.

Instruction Manual

Magnescale website
http://www.magnescale.com/mgs/language/english/
product/
Under Digital Gauge



安全上の注意

●注意表示の意味

 注意

正しい取扱いをしなければ、この
危険のために、時に軽症・中程度
の傷害を負ったり、あるいは物的
損害を受ける恐れがあります。

●注意表示

 注意

通電中は、端子部に触れたり、本製品を分
解して内部に触れたりしないでください。
感電の恐れがあります。

本製品を分解して修理や改造はしないでく
ださい。感電の恐れがあります。

● 規定された電源電圧以外での電圧で使
用しないでください。火災や感電の原
因となる恐れがあります。

● 濡れた手での取付作業はしないでくだ
さい。感電の原因となります。

● 本製品を分解、改造しないでください。
火傷やケガの恐れがあります。分解・
改造された製品は保証できません。

● ケーブルを傷つけたり、加工したり、
無理に曲げたり、引張ったりしないで
ください。また、重いものをのせたり、
熱したりしないでください。ケーブル
が破損し、火災や感電の原因となる恐
れがあります。

● 本製品の取付作業を行なう際や、取付けた装置を
動作させる場合には、充分な安全を確保してくだ
さい。

● 信号ケーブルの抜き差しの際は、ケーブルでなく
必ずプラグの部分を持って行なってください。

● 本製品は防爆構造になっていませんので、可燃性
ガスの雰囲気中では使用しないでください。火災
の原因となることがあります。

● 設置中や操作中に異常 ( 煙・音・匂いなど ) が発
生した場合、すぐに接続ケーブルを外して、サー
ビスにご連絡ください。そのまま使用すると火災
や感電、故障の原因となります。

使用上の注意

● 取扱説明書に示すとおり、正しく接続してくださ
い。正しく接続しないと、故障する恐れがありま
す。

● 次のような環境には設置しないでください。

・ 日光が直接当たる場所

・ 周囲温度や相対湿度が仕様値の範囲を超える場
所

・ 温度の変化が急激で結露するような場所

・ 腐食性ガス、可燃性ガスのある場所

・ ちり、ほこり、塩分、鉄粉が多い場所

・ 水、酸、油、薬品などの飛沫がかかる場所

・ 本体に直接振動や衝撃が伝わる場所

● 次のような場所で使用する際は、遮蔽対策を充分
に行なってください。

・ 静電気などによるノイズが発生する場所

・ 強い電界や磁界が生じる場所

・ 放射能を被曝する恐れのある場所

・ 電源線や動力線が近くを通る場所

● 製品を落下させたり異常な振動や衝撃を加えたり
しないでください。故障や誤動作の原因となりま
す。

● 本製品を輸送するときは、専用の梱包箱を使用し
てください。また、輸送中に過度な振動や衝撃が
加わらないように注意してください。

● 取扱説明書に示すとおり、正しく配線してくださ
い。

カウンタモジュール
Counter module

MG71-CM

補足説明書 / Supplement

お買い上げいただき、ありがとうございます。

安全にご使用いただくために、本紙と各取扱説明書
を必ずお読みください。

取扱説明書は当社ホームページからダウンロードい
ただくか、最寄りの営業所にお問い合わせください。

ご使用に際しては、本紙と取扱説明書どおりにお使
いください。

お読みになった後は、後日お役に立つこともござい
ますので、必ず保管してください。

h ank you for purchasing this product.

To ensure safe operation, please be sure to read this 
document and each instruction manual carefully.

To obtain the instruction manuals, download them 
from the website of Magnescale Co., Ltd. or contact your 
nearest sales representative.

Be sure to operate the product according to the 
descriptions in this document and the instruction 
manuals.

Be sure to keep this document and all instruction 
manuals in a safe and readily available location for future 
reference.

概要

MG71-CMは、Bernecker + Rainer Industrie 
Elektronik（以下、B&Rと記載）のカウンタモジュー
ルを（株）マグネスケールが販売するものです。

MG71-CMの基本的な仕様に関しては、以下に示す
B&R製品の資料をご覧ください。

Magnescale
モデル番号

B&R
モデル番号

説明 B&R Web リンク

MG71-CM X20DC11A6 デジタル
カウンタ・
モジュー
ル

http://www.br-
automation.com/
en/products/io-
systems/x20-system/
counter-functions/
x20dc11a6/

X20BM11 デジタル
カウンタ・
モジュー
ル用
ベース・
モジュー
ル

http://www.br-
automation.com/en/
products/io-systems/
x20-system/bus-
modules/x20bm11/

X20TB12 端子台 http://www.br-
automation.com/en/
products/io-systems/
x20-system/terminal-
blocks/x20tb12/

取扱説明書

弊社ホームページ
http://www.magnescale.com/mgs/product
Digital Gauge カテゴリ内
MG70-EI またはMG70-PN
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Safety Precautions

 Definition of Precautionary Information

 Caution

Indicates a potentially 

hazardous situation which, 

if not avoided, may result in 

minor or moderate injury, or 

property damage.

 Cautions

 Caution

Do not attempt to take any unit apart 

while the power is being supplied. Doing 

so may result in electric shock.

Do not attempt to disassemble, repair, or 

modify any units. Any attempt to do so 

may result in electric shock.

 Do not use the product at voltages other 

than the specified power voltage. This 

could result in a fire or electric shock.

 Do not perform installation work with 

wet hands. This could result in an 

electric shock.

 Do not disassemble or modify the 

product. This could result in a burn 

or other injury. Disassembling or 

modifying the product will void the 

warranty.

 Do not damage, modify, excessively bend, 

pull on, place heavy objects on or heat 

the cable. This could damage the cable 

and result in a fire or electric shock.

PRECAUTIONS FOR SAFE USE

 Take all possible safety measures when mounting 

the product and operating a mounted device.

 When connecting and disconnecting a signal 

cable, be sure to grasp by the plug section, not 

the cable.

 The product does not have an explosion-proof 

structure. Therefore, do not use the unit in an 

atmosphere containing flammable gas. This 

could result in a fire.

 If anything unusual (smoke, sound, smell, 

etc.) occurs during installation or operation, 

immediately unplug connection cables and 

contact the Service Center. Continued usage in 

this situation can result in a fire, electric shock, 

or breakdown.

PRECAUTIONS FOR CORRECT USE

 Connect cables to the unit property as shown 

in the instruction manual. Not doing so may 

result in a failure of the unit.

 Do not install the unit in the following places:

• Locations subject to direct sunlight

• Locations subject to temperatures or 

humidity outside the range specified in the 

specifications

• Locations subject to condensation as the result 

of severe changes in temperature

• Locations subject to corrosive or flammable 

gases

• Locations subject to dust (especially iron dust) 

or salts

• Locations subject to exposure to water, acid, 

oil, or chemicals

• Locations subject to shock or vibration

 Take appropriate and sufficient countermeasures 

when using the unit in the following locations:

• Locations subject to static electricity or other 

forms of noise

• Locations subject to strong electromagnetic 

fields

• Locations subject to possible exposure to 

radioactivity

• Locations close to power supplies

 Do not drop the product to the ground or expose 

to excessive vibration or mechanical shocks. The 

product may be damaged and may not function 

properly.

 Use a dedicated packing box to transport the 

unit. Avoid excessive shock or vibration during 

transportation.

 Wire the unit properly as shown in the 

instruction manual.

Overview

The MG71-CM is a Counter module created by Bernecker 
+ Rainer Industrie Elektronik (hereafter, B&R) and sold 
by Magnescale Co., Ltd.

For the MG71-CM specifications, refer to the B&R product 
documentation listed below.

Magnescale
model 
number

B&R
model 
number

Description B&R Web link

MG71-CM X20DC11A6 Digital 
counter 
module

http://www.br-
automation.com/en/
products/io-systems/
x20-system/counter-
functions/x20dc11a6/

X20BM11 Base 
module 
for digital 
counter 
module 

http://www.br-
automation.com/en/
products/io-systems/
x20-system/bus-
modules/x20bm11/

X20TB12 Terminal 
block

http://www.br-
automation.com/en/
products/io-systems/
x20-system/terminal-
blocks/x20tb12/

Instruction Manual

Magnescale website
http://www.magnescale.com/mgs/language/english/
product/
Under Digital Gauge
MG70-EI or MG70-PN
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